
COURSE IDENTIFICATION 

Course Title:  Foundations Digital Imaging and Design 

 

Description and Prerequisites 

 
This is a required course for all art majors, providing them with a foundational knowledge of digital 
media and an understanding of working with the elements and principles of art and design. 
 

Textbooks and Required Materials 

 
There is no required textbook. 
 
Students must have Adobe Creative Suite 6 and a digital camera capable of uploading photos to a 
computer. 
 

COURSE OUTCOMES & OBJECTIVES 

 

Outcomes Objectives 

Knowledge  

Understand the history, current issues, and 
direction of the artistic discipline 

Gain a fundamental understanding of digital 
imaging and media and its history, theory, 
and criticism. Place works in the historical, cultural, and 

stylistic contexts  of the artistic discipline 

Use the technology and equipment of the 
artistic discipline 

Acquire knowledge of technologies and 
equipment of digital imaging and media. 

Skills   

Use the elements and principles of art to 
create artworks in the artistic discipline 

Demonstrate increasing ability to utilize key 
concepts in the discipline of art and design in 
order to create and develop media 
productions. 

Create artwork that demonstrates perceptual 
acuity, conceptual understanding, and 
technical skill 

Analyze and evaluate works of art in the 
artistic discipline 

Develop skill in applying knowledge of media 
theory and criticism to products n the 
discipline. 

Synthesis  

Produce artworks demonstrating technical 
skill and disciplinary knowledge 

Produce works of digital media 
demonstrating technical skill and disciplinary 
knowledge. 

Use knowledge of art and disciplinary 
vocabulary to analyze artworks 

Understand and apply disciplinary knowledge 
and vocabulary in media criticism. 

Participate in critiques of own work and work 
of others 

Apply knowledge of media criticism and 
theory in critique of student work. 
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CLASS SCHEDULE 

 
Week Date Topics and Assignments Assessments 

1  Course Introduction  
Appropriating and presenting images 

Project 1 
Collect 12 images 
Present as PowerPoint, Word doc, and as 
web-based college 

2  Creating and editing digital photographs Project 2 
Shoot and edit 12 original digital 
photographs; present as Photoshop 
slideshow 

3  Social media Project 3 
Research paper 

4  Image + text Project 4 
Create an internet meme and track its 
impact; write 200-word reaction paper 

5  Basic web format and site layout Project 5-Part 1  
Design website front page 
Set up website account 

6  Adding text, images, and pages Project 5-part 2 
Add pages to website 

7  Adding video and interactive components 
Analytics  

Project 5-Part 3 
Add interactive components 
Publish site 
Track analytics 

8  Mid-Term Critique Mid-term Critique 
Artist’s Statement due 

9  Introduction to graphic design with Adobe 
Illustrator 

Project 6-Part 1 
Design ¼ page advertisement with 
Illustrator 
 

10  Creating composite images with Photoshop Project 6-Part 2 
Create a composite photograph 

11  Creating a multi-media newsletter with 
Adobe InDesign 
 

Project 6-Part 3 
Create brochure with InDesign 

12  Continue working on Project 6 Project 6-Part 4 
Create newsletter with InDesign, including 
--advertisement 
--2 or more photos 
--composite photo 
--articles/text  

13  Continue working on Project 6 

14  Individual instructor critiques 

15  Final Critique Final Critique 
Personal Statement due 
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ASSIGNMENT & ASSESSMENTS 

 
  

Assessment Value (of 100) 

Participation in class discussions and assignments 
 
Social media research paper 

10 
 
5 

--Finding and appropriating images 
--meme creation and research 
--brochure creation 

5 points each x 3 = 15 

--Digital photography assignment 
--Adobe Illustrator advertisement 
--website design 
--Photoshop composite mage 

 
10 points each x 4 = 40 

Final project—Newsletter produced using Adobe 
InDesign incorporating elements of other 
assignments in the course. 

15 

Vocabulary quiz  
 

5 

Participation in critique 
 

10 
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Attachments-1 
 

Written directions for assignments 
 

 
1—Appropriating and presenting images 
Part 1-Collecting Images 

 Using Google Images or other image databases, collect 12 high quality images.  

o The images should have a recognizable central theme  

 A theme is different than a topic.  A topic is concrete, such as “Polar Bear.”  A 

theme is abstract, such as “Environment.” 

 Your collection should communicate this abstract idea (the theme) in a visual 

way. 

o There must be no text, watermark, or other inclusions on the images you choose. 

o Images should be larger than 1024 x 768 (you can find this in the menu under Search 

Tools…Large…Larger Than). 

 Don’t settle for the first 12 images you find.  Search extensively and collect at least twice as 

many images than you need, then narrow your results to your top 12 choices.  Delete the un-

used items. 

 Save the final collection of images in a folder on your computer’s desktop, labeled Project 1. 

Part 2 
Import to PowerPoint 

 Open a new Power Point presentation 

 Click the Insert tab 

o select Photo Album, then New Photo Album 

 Choose Insert file from File/Disk 

 Select the pictures you want to import (the ones in the Project 1 folder on your desktop).  Click 

Insert. 

 Click Create.  The photos will appear in your presentation on separate slides. 

 Format the presentation using the Design tab.  (A solid background looks best with photos.  Go 

to Background Styles and make your choice) 

 The title of your presentation should be the word you’ve chosen as your theme. 

 Your name should go in the text box beneath the title. 

 Save your presentation as “LastName_Project-1.pptx” in the Project 1 folder on your desktop. 

Insert in Word doc 

 Open a new Word document 

 Use Word Art to give your project a title (your project’s theme), and put your name on the 

document as well. 

 Insert your photos 

o Go to Insert, then Picture 

o Select the picture, then format the picture using the Wrap Text tab (in the Format 

menu).  Hint: to avoid distortion, handle the image by the corners, not in the middle of 
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the sides). 

o You’ll have to do this one  image at a time.  All images should be sized to fit on a single 

page. 

o Arrange the images in a collage.  Be creative! 

 You may add drawing elements or enhance the project with Artistic Effects (these are located in 

the Format menu, which is only visible if an image is selected in your document) 

 Save your document as “LastName_Project1.docx” and put it in the folder on your desktop. 

Create Web Collage 

 Use a photo collage website to create the next part of your project. 

o www.pizap.com 

o www.photovisi.com 

o www.picmonkey.com 

 Follow the instructions to create your collage using all 12 photos on a single page. 

 Save the collage as a PDF or JPG file as “LastName_Project1.pdf” or “Lastname_Project1.jpg”  

and put it in the Project 1 folder on your desktop 

 Due Date 

 When all three parts of your project have been completed and are in the folder on your 

desktop, create a zipped (compressed) folder containing the entire folder: the 12 original 

images, the PowerPoint, the Word doc, and the PDF or JPG of the web collage.  Be certain that 

your folder is labeled “LastName_Project1.zip” 

 Email the zip folder to the instructor by midnight the night before the first class period of Week 

2. 

 
2—Digital Photography 
Part 1: Shooting Photographs 

 This week, you’re going to create body of photographs depicting the idea of the passage of 
time.   

 Your final collection should include 12 edited images, but you will likely shoot many more 
photos than that before narrowing down to your best 12. 

Part 2: Photo Editing 

 When you’ve decided on your 12 best photographs, you’ll use Photoshop to edit and adjust the 

images. 

 The goal is to sharpen, color balance, crop, or otherwise refine the photographs, but not to 

apply special effects, insert things that aren’t actually there, or eliminate things that are there.  

(We’ll do that later in the course). 

Part 3: Presenting your photos 

 To present the body of work you’ve created, you’ll create a slideshow in Photoshop. 

 http://tv.adobe.com/watch/understanding-adobe-photoshop-cs6/create-a-slideshow-in-

photoshop/  

Resources 

 The Adobe TV website offers a variety of helpful video tutorials for using Photoshop: 

 http://tv.adobe.com/show/understanding-adobe-photoshop-cs6/  
Due Date 

http://www.pizap.com/
http://www.photovisi.com/
http://www.picmonkey.com/
http://tv.adobe.com/watch/understanding-adobe-photoshop-cs6/create-a-slideshow-in-photoshop/
http://tv.adobe.com/watch/understanding-adobe-photoshop-cs6/create-a-slideshow-in-photoshop/
http://tv.adobe.com/watch/understanding-adobe-photoshop-cs6/create-a-slideshow-in-photoshop/
http://tv.adobe.com/show/understanding-adobe-photoshop-cs6/
http://tv.adobe.com/show/understanding-adobe-photoshop-cs6/
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 You must email your slideshow to the instructor before the first day of class in Week 3. 

 Be certain that your file name begins “LastName_Project2” followed by the file type 

 
3—Social Media 
Research and Writing 

 You will research and write about social media.  Your paper should include the following main 

ideas: 

o A brief history of social media 

o A description of your personal relationship to social media (platforms used, frequency 

of use, content followed, content posted) 

o The role of art and design in social media 

o Social media as a professional tool 

o Curating your online presence 

o Speculation about the future of social media (where do you think we’ll be 5 years from 

now?) 

Paper Specifications 

 Your paper should be  

o 1200 -1800 words long,  

o Times New Roman font—black only  

o double-spaced, with 1-inch margins 

o This is 5 to 7 pages long, NOT including the references or any images you care to cite. 

o You must include a running header with your last name and the paper title, and a footer 

with page numbers 

 Images must be included as an appendix, not embedded in the body of the paper. 

 All sources must be cited correctly using standard MLA or APA format. 

 You must include a correct bibliographic citation for every written or artistic work you cite. 

 Papers will be submitted to TurnItIn, SafeAssign, or other checking software. 

 Plagiarism will result in an irrevocable grade of F on the paper. 

 Do not use Wikipedia as a source.  Do not cite Google as a source. 

 
 
Due Date 

 Email your paper as a Word doc to the instructor no later than midnight on the day before the 

first class period of Week 4. 

 The file name should be “LastName_Project3.docx” 

 
4—Image and Text 

 You may use an appropriated image or your own photo 

 Your text must be your own composition  

 You may not just copy an existing meme 

 Post your meme to your favorite social media site 

 After 2 days, take a screenshot of the comments generated by your meme 
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 After 3 days, do a Google search and see if your meme has spread beyond your circle of 

friends/contacts on social media. 

 Write a 200-word response to this activity and attach a screenshot of your meme and the 

comments you received.  (combine as single PDF) 

 Title the document “LastName_Project4.pdf.” 

 Email to the instructor by midnight of the night prior to the first class in Week 5. 

 
 
Weeks 5-7—Web Design 

 Week 5: design your front page.  Also: set up your website account with a free web-hosting 

service 

o Headline 

o Text 

o Images 

 Week 6: add pages for 

o Blog 

o Your artwork 

o Your writings 

o Links to other content 

 Week 7: improve your design.  Add animation or video.  Introduction to Google Analytics. 

 Email the instructor the URL for your website.   

 Websites will be presented to the class at the Mid-term Critique during Week 8. 

 
5—Web Design, Part 1 

 Go to this site: http://www.virtualmechanics.com/products/dwarf/ 

 Download the Web Dwarf software. 

o There are plenty of programs out there, but this one is free and is designed to be easy 

to use.  It will work with Adobe Dreamweaver once you get your pages designed. 

 You’ll also need to set up an account with a website hosting service of your choice.  Choose one 

that’s free, such as Weebly.com . 

6—Web Design, Part 2 

 Add pages to the website: 
o Blog 
o Art Gallery 
o Writing 
o Links 

 
7—Web Design, Part 3 

 Publish your Website 

 Set up an analytics account 

 After publishing your site, share the link on your social media sites.  Tell everybody you know to 

check it out. 

 Once per day—for at least 5 days—check your analytics and see who looked at your site.  

http://www.virtualmechanics.com/products/dwarf/
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Perform a content drilldown to see what they looked at. 

 The day before our Mid-Term Critique, print a report of your analytics and bring it to class for 

the critique to tell us how many visitors you’ve had and which pages they found to be 

interesting. 

 
8—Mid-term Critique 
 
Project 6 Description 

 Your final project will be a newsletter that incorporates: 

o Your advertisement from Week 9 

o Your composite photo from Week 10 

o At least two of your photos from Week 2 

o Four articles that you write yourself (not appropriated from another source: 

 A user-review of the Adobe products we’ve used 

 A news report about your Internet meme: has it gone viral?  Why or why not?  

What is your evidence? 

 A review of a website you like  

 A 300-word excerpt from or summary of your paper about social media 

o A banner headline, page numbers, and an overall visual theme 

 You will present your newsletter at the final critique. 

 You will email a PDF copy of your newsletter to the instructor prior to the final critique. 

 
Project 6: Timeline 

 Week 9-Part 1: Adobe Illustrator-designing an advertisement 

 Week 10-Part 2: Adobe Photoshop-creating a composite image  

 Week 11-Part 3: Adobe InDesign-creating a brochure 

 Week 12-Part 4: Adobe InDesign-creating a newsletter 

 Week 13-work time/individual tutorials 

 Week 14-individual instructor critiques and Quiz  

 Week 15-Final Critique 

NOTE: all parts of the project are due the first day of the following week, usually submitted to the 

instructor electronically. 

 
 
9—Introduction to Adobe Illustrator 

 You’re going to make a ¼ page advertisement for an imaginary business. 

 This could be for your own art gallery, web design firm, classic car restoration shop…anything 

goes (but G-rated, please.  Remember, it will end up on your website) 

 The design must incorporate: 

o Banner headline 

o Informational text 

o A business logo 
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o A callout 

o Contact information for the business 

o A border 

 The layout of the design should exemplify your mastery of the elements and principles of art 

and design. 

 It should demonstrate excellent craftsmanship and attention to detail. 

 Due at the start of Week 10.   

 
10—Creating a composite image in Photoshop 

 Choose three different photos: 

o A background or landscape 

o A person 

o A large object (vehicle, piece of furniture…) 

 Use Photoshop to create a composite image in which you place the person the large object in 

your background. 

o No visible edges 

o Appropriate perspective and proportion 

o Colors/tones adjusted for visual consistency 

 Save the composite as .psd file.  Save a copy as a .jpg file. 

 Submit a zipped folder containing your jpg composite and all 3 source images. 

 Title the file and the composite: “LastName_Project6.2” 

 
11—Creating a brochure using Adobe InDesign 

 Consistent layout and overall theme 

 Good craftsmanship and attention to detail 

 Skillful use of the elements and principles of art and design 

 Content: 
o Your advertisement from Week 9 
o A photo from Week 2 
o Any other text or photos 
o Tri-fold design with content on all 6 panels (front and back of the brochure) 

 When your brochure is completed, save it as a .indd file.  Save a copy as a .pdf. 

 Email the pdf version to the instructor 

 Print the final version and bring a copy to the next class. 
 
12-15—Creating a newsletter using Adobe InDesign 

 Consistent layout and overall theme 

 Good craftsmanship and attention to detail 

 Skillful use of the elements and principles of art and design 

 The final newsletter should be 3 to 4 pages long 

 Content: 

o Your advertisement from Week 9 
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o Your composite photo from Week 10 

o At least two of your photos from Week 2 

o Four articles that you write yourself (not appropriated from another source: 

 A user-review of the Adobe products we’ve used 

 A news report about your Internet meme: has it gone viral?  Why or why not?  

What is your evidence? 

 A review of a website you like  

 A 300-word excerpt from or summary of your paper about social media 

o A banner headline, page numbers, and an overall visual theme 

 You will present your newsletter at the final critique. 

 You will email a PDF copy of your newsletter to the instructor prior to the final critique. 

 When your newsletter is completed, save it as a .indd file.  Save a copy as a .pdf. 

 Email the pdf version to the instructor prior to the Final Critique in Week 15. 

 
  
 

 

 


